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RESUMO 

A busca pelo aumento da produtividade dos empreendimentos florestais, criou a 

necessidade de elevar o nível de mecanização das atividades. Objetivou-se com este 

trabalho avaliar a aptidão das áreas do estado do Espírito Santo à implementação da 

colheita de madeira mecanizada, utilizando o sistema de toras curtas. Objetivando 

criar o zoneamento das áreas aptas, utilizou-se informações referentes à declividade, 

Uso e Ocupação da Terra (UOT) e tamanho mínimo da área. Para as classes de 

aptidão referentes à declividade, foram criadas três categorias: apta (0 - 27º), apta 

com uso de guincho de tração auxiliar - GTA (27,1 - 35º) e inaptas (>35º), através de 

informações obtidas através do Google Earth Engine. Já para o mapeamento 

referente ao UOT, utilizou-se ortofotos disponibilizadas pelo IEMA. O uso e ocupação 

da terra do Espírito Santo foi classificado como apto, apto com restrição, inapto e 

impróprias. As Unidade de Conservação (UC) e suas respectivas áreas de 

amortecimento foram determinadas conforme o plano de manejo de cada UC, 

disponibilizado pelo ICMBio (Federais) e IEMA (Estaduais), sendo estas, classificadas 

como impróprias. Utilizando o software ArcGis 10.3 foram realizadas as combinações 

dos mapas de declividade com o mapa de UOT, delimitando as áreas aptas para 

implementação da colheita florestal mecanizada. Os resultados demonstraram que o 

estado apresenta 44,00% de toda a sua área apta à implementação de, podendo ser 

implantada em todas as microrregiões do Estado. Em 42,83% da área do estado a 

declividade é superior a 35º e/ou o uso e ocupação da terra destina-se a outras 

atividades que impede a utilização de maquinários, tornando essas áreas inaptas. O 

Espírito Santo apresenta 10,53% de seu território destinado as Unidades de 

Conservação, caracterizando estas regiões como impróprias. Com relação a utilização 

do GTA, apenas a microrregião Nordeste não permite o emprego desta tecnologia. 

Diante do exposto, foi possível quantificar as áreas aptas à implementação da colheita 

mecanizada no Espírito Santo, além de demonstrar que é possível elevar o nível de 

mecanização no estado. 

Palavras chaves: Operações florestais; geotecnologias; uso e ocupação da terra; 

declividade; mecanização. 
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1.INTRODUÇÃO 

Conforme informações da Indústria Brasileira de Árvores (2018), o Brasil 

apresenta uma área de 7,84 milhões de hectares de florestas plantadas, responsável 

por cerca de 90% de toda a madeira de uso industrial produzida no país. Diversos 

produtos e subprodutos, como a celulose, papel, painéis de madeira, pisos laminados, 

carvão vegetal e biomassa são oriundos das florestas plantadas. O setor florestal 

brasileiro gera uma receita bruta de R$ 73,8 bilhões, significando 6,1% do PIB 

industrial e 1,1% do PIB brasileiro.  

Para o estado do Espírito Santo, o setor florestal corresponde a 25% do PIB do 

agronegócio estadual, gerando 80 mil empregos diretos e indiretos (CEDAGRO, 

2011). O estado é o sexto maior produtor de eucalipto, com uma área de 233.760 ha, 

enquanto para árvores de pinus se encontra na nona posição com 2.500 ha (IBÁ, 

2017). 

Os empreendimentos florestais tem se consolidado entre as principais 

atividades do agronegócio, devido às altas produtividades, elevada demanda de 

madeira e ao incremento constante de novas tecnologias no setor. A crescente 

demanda por madeira para diversas finalidades, implicou na expansão das áreas 

florestais além do aumento da necessidade de técnicas para facilitar a colheita. 

A colheita de madeira é o conjunto de operações que envolvem a preparação 

e retirada da madeira do interior do talhão para o local de transporte. Tais atividades 

abrangem o corte (derrubada, desgalhamento e traçamento), a extração (retirada da 

madeira do interior do talhão até o pátio ou margem da estrada) e o empilhamento 

nas margens das estradas ou pátios. A colheita de madeira é uma operação que 

requer atenção especial, pois pode variar conforme a topografia do terreno, o 

rendimento volumétrico do povoamento, o tipo de floresta, o uso da madeira e as 

máquinas e equipamentos disponíveis (MACHADO, 2014). 

Das atividades relacionadas à produção de madeira, a colheita é a etapa mais 

importante economicamente, pois pode representar valores acima de 50% dos custos 

totais (MACHADO, LOPES, 2000; JACOVINE et al., 2005). Devido aos elevados 

custos, é preciso otimizar as atividades, de modo a maximizar a produção e reduzir 

os gastos e o tempo de execução. 
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No entanto, mesmo com toda tecnologia utilizada no setor, o Brasil fica aquém 

no desenvolvimento de inovações relacionadas à mecanização florestal, quando 

comparado a alguns outros países. As novidades implantadas no setor florestal, 

tendem, na maioria das vezes, a ser em áreas com relevo plano a pouco ondulado. 

Em muitos casos, os maquinários utilizados na colheita florestal, são adaptados, 

havendo uma carência de estudos e tecnologia para áreas declivosas (MACHADO, 

2014; BRINATE, 2016).  

O Espírito Santo apresenta regiões com predomínio de relevos acidentados, 

dificultando a inserção de máquinas de grande porte para a realização da colheita de 

madeira. Portanto, perante as dificuldades, tornam-se necessários estudos que 

indiquem regiões aptas à implementação da colheita de madeira mecanizada no 

estado. Este trabalho justifica-se também devido a carência de trabalhos relacionados 

a esta abordagem no Espírito Santo. 
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1.1 Objetivos 

 

1.1.1. Objetivo Geral 

Avaliar a aptidão das áreas do estado do Espírito Santo, Brasil, à 

implementação da colheita de madeira mecanizada, utilizando o sistema de toras 

curtas. 

 

1.1.2. Objetivos Específicos  

• Determinar possíveis áreas à implementação de cultivo florestal;  

• Definir classes de declividade e uso e cobertura da terra;  

• Definir regiões aptas à mecanização da colheita de madeira, através do 

cruzamento de informações relativas à declividade e uso e ocupação do solo.  
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2. REVISÃO DE LITERATURA 

2.1. O setor florestal brasileiro 

O início do setor florestal brasileiro ocorreu com introdução do gênero 

Eucalyptus no interior do estado de São Paulo em 1903. Navarro de Andrade trouxe 

as primeiras sementes de eucalipto objetivando encontrar uma solução para a 

produção de dormentes, postes e lenha para ferrovias e locomotivas (GONÇALVES, 

2011). 

A partir da década de 1960, com a aprovação da Lei nº5.106, de setembro de 

1966, o setor florestal brasileiro começou a se desenvolver com maior rapidez, devido 

aos incentivos fiscais aos empreendimentos florestais. Tal lei, permitia reduzir até 50% 

do valor de imposto de renda. No ano de 1976, o Brasil era o quarto país a mais 

incentivar a produção florestal no mundo, ficando atrás de China, União Soviética e 

Estados Unidos (LEÃO, 2000; SOARES; SOUZA; SILVA, 2008; MACHADO et al., 

2014). 

Em 1998, os incentivos fiscais ao reflorestamento foram extintos, devido a 

deficiências técnicas na utilização dos recursos disponíveis. Entretanto, mesmo com 

o fim dos incentivos fiscais, o setor florestal continuou a se desenvolver devido às 

grandes empresas de base florestal que continuavam a ampliar suas áreas de plantio 

(SOARES; SOUZA; SILVA, 2008). 

O Brasil possui aproximadamente 58% de seu território coberto por florestas, 

sendo que 7,8 milhões de hectares eram ocupados por florestadas plantadas no ano 

de 2017. Além disso, o país lidera o ranking mundial de produtividade florestal, tendo 

médias de 35,7 m³/ha e 30,5 m³/ha para plantios de eucalipto e pinus respectivamente.  

O setor de árvores plantadas teve uma participação de 6,1% no PIB industrial, 

colaborando com 1,1% de toda a riqueza gerada no país no ano de 2017, empregando 

diretamente 508 mil pessoas (SNIF, 2017; IBÁ, 2018). 

Durante o ano de 2017, o setor florestal brasileiro teve um investimento de R$ 

6,7 bilhões (IBÁ, 2018). As atividades relacionadas a colheita de madeira têm recebido 

os maiores investimento, devido a sua complexidade e o objetivo de reduzir os custos, 

resultando na utilização de máquinas de alta tecnologia e produtividade (MACHADO 

e LOPES, 2008). 
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2.2. Colheita de madeira 

Pode-se definir a colheita florestal, como um conjunto de atividades que 

ocorrem no interior do povoamento florestal, que envolve a preparação e a retirada da 

madeira até o local de transporte. O corte (derrubada, processamento e 

descascamento), o empilhamento e a extração da madeira, são fases da colheita 

florestal que podem representar até 50% dos custos totais da madeira, sendo o 

estágio mais importante do ponto de vista técnico - econômico (LOPES et al., 2008; 

MACHADO, 2008). 

A colheita florestal é uma atividade complexa, podendo ser influenciada por 

fatores de ordem técnica, econômica, ambiental, ergonômica e social, que podem 

interferir na produtividade e nos custos da operação (BURLA et al., 2012). Por essa 

razão, um eficiente planejamento e controle das operações é essencial para redução 

dos custos, otimização do trabalho e melhoria na qualidade do produto (SANTOS et 

al., 2014).  

Por ser a operação final de um ciclo de produção florestal, da qual são obtidos 

os produtos mais valiosos, a colheita florestal pode determinar a rentabilidade do 

empreendimento (ARCE et al., 2004). Portanto, torna-se necessário desenvolver 

técnicas que possibilitem maior beneficiamento da madeira com menor custo e perda 

de matéria-prima, intensificando a mecanização da colheita florestal (JACOVINE et 

al., 2001; SIMÕES et al., 2010). 

De acordo com Lima e Leite (2014), o grau de declividade do terreno é uma 

das variáveis mais influentes na colheita florestal, sendo uma relação inversamente 

proporcional. Ou seja, conforme a elevação do grau de declividade, menor será o 

rendimento e maior será os custos referentes a esta atividade. Portanto, a colheita 

florestal em áreas acidentadas, demanda planejamento e detalhamento das 

operações, visando a utilização de máquinas e equipamentos específicos para essas 

condições (LIMA e LEITE, 2002).  

 

2.3. Sistemas de colheita de madeira 

Malinovski et al. (2014), classifica os sistemas de colheita da madeira como o 

conjunto de processos e procedimentos inter-relacionados desde o corte até a 

disposição da madeira nas margens de estradas e/ ou pátios intermediários. Esse 
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conjunto de atividades, possibilita um fluxo ininterrupto de madeira, objetivando à 

racionalização e otimização dos recursos (MALINOVSKI, 2008).   

Diversos sistemas de colheita e processamento da madeira podem ser 

utilizados conforme a espécie florestal, a idade do povoamento, o destino da matéria 

prima e as condições gerais da colheita. Portanto, para cada condição específica, 

existe um método de colheita mais recomendado para que se proceda com a colheita 

e o beneficiamento da madeira (SILVA et al., 2003).  

Os sistemas empregados na colheita de madeira brasileira são: árvores inteiras 

(full tree), toras curtas (cut to length) toras longas (tree length) e árvores completas 

(whole tree) (LEITE, et al., 2014). De acordo com Billo (2019), apesar do consagrado 

sistema de cavaqueamento (chipping), o mesmo possui a mesma definição do sistema 

de árvores inteiras, entretanto são processadas na forma de cavacos.  

Para determinar qual sistema e os maquinários utilizar, deve-se realizar 

estudos para detalhar os custos e rendimentos, infraestrutura de assistência técnica 

e treinamento dos operadores (MACHADO, 2014). 

 

2.3.1. Sistema de árvores inteiras (Full Tree) 

Esse sistema baseia-se na derrubada de árvores no interior do talhão, sendo 

estas arrastadas para a margem do talhão ou pátio para serem processadas. O 

sistema de árvores inteiras, requer alto grau de mecanização e máquinas de grande 

porte, sendo que suas atividades podem ser realizadas tanto em regiões planas como 

declivosas (MALINOVSKI et al., 2014). 

Além de ser utilizado para produção de celulose, o sistema de árvores inteiras 

é empregado também na produção de biomassa para energia, pois permite a 

utilização da casca, ramos e folhas. O risco de incêndios nesse sistema é inferior aos 

outros, uma vez que diminui os resíduos das áreas, deixando a área limpa 

(MALINOVSKI, 2008).  

 

2.3.2. Sistema de toras curtas (Cut to lengh) 

O sistema de toras curtas é o mais utilizado no Brasil, sendo empregado 

principalmente na colheita de Eucalyptus, por empresas produtoras de celulose 

(MALINOVSKI et al., 2008). Esse é o método mais utilizado, por se tratar de um 
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sistema de alta produtividade, por reduzir os custos de produção, por facilitar o 

deslocamento em pequenas distâncias e por propiciar uma menor agressão ao solo 

(NOVAIS, 2006; LEITE, 2012).  

No sistema de toras curtas, o processamento da árvore é feito no local da 

derrubada, sendo extraída para a margem da estrada ou para pátios temporários em 

toras de até 6 metros de comprimento (MALINOVSKI et al., 2002; GONÇALVES, 

2011). Neste sistema, galhos e folhas são deixados no talhão, reduzindo o custo com 

transporte e diminuindo a extração de nutrientes do interior da floresta (MACHADO, 

2014). 

Malinovski et al. (2014), afirmam que este sistema permite a utilização de 

métodos manuais e semimecanizados. Entretanto, mesmo permitindo a utilização de 

menores declividades, os modais mais utilizados nesse caso são compostos por: 

colhedor-processador florestal (Harvester) que realiza a derrubada, o desgalhamento, 

o destopamento, o descascamento e o traçamento e em seguida o trator florestal 

autocarregável (Forwarder) que realiza a extração até a margem da estrada ou até o 

local de transporte (MACHADO, 2014).  

 

2.4. Colheita florestal em áreas declivosas 

Em regiões acidentadas, a colheita de madeira representa uma atividade de 

extrema dificuldade nos empreendimentos florestais, pois geralmente precisa ser 

executada sob condições adversas. Por esse motivo, o sistema de colheita nessas 

áreas, necessita de máquinas especiais para que a atividade ocorra com o mínimo 

impacto ambiental possível (BANTEL, 2010).  

A declividade é um fator limitante à implementação de máquinas e 

equipamentos na colheita de madeira. Devido a este fato, a motosserra ainda é 

utilizada nessas operações. Entretanto, com a necessidade de aumentar a 

produtividade, grandes maquinários como o Harvester e forwarder passaram a ser 

utilizados nessas regiões (ROBERT et al., 2018). 

Thees, Fruting e Fenner (2011), afirmaram que em locais com topografia 

acentuada, o rendimento da produtividade florestal mostrou-se menor, quando 

comparada a regiões planas. Portanto, se faz necessário desenvolver e implementar 
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tecnologias que elevem o rendimento dos maquinários no Brasil, e, 

consequentemente aumentar a produtividade e melhorar as condições de trabalho.  

 

2.5. Colheita mecanizada 

Sant’anna (2014), define a colheita mecanizada como o método totalmente 

mecanizado, onde se tem o emprego de maquinários que realizam todas as 

operações envolvidas nos processos da colheita. O aumento da demanda por 

produtos madeireiros, juntamente com o crescimento da produtividade das atividades 

florestais, foi incentivado pelo surgimento de novas máquinas e equipamentos 

(SOUZA, 2001) 

Para Machado (2008), as empresas florestais faziam pouco uso da 

mecanização nas operações florestais no início das atividades de reflorestamento. 

Porém, na década de 90, com a abertura das importações, aumento do custo da mão-

de-obra e da necessidade de realizar as atividades de maneira mais ergonômica e 

com maior eficiência, as empresas passaram a implementar a mecanização na 

colheita de maneira mais significativa. 

Durante as últimas décadas houve um grande avanço tecnológico em relação 

às máquinas florestais, permitindo ganhos de produtividade e redução dos custos. As 

maquinas de colheita de madeira se dividem em máquinas de corte e máquinas de 

extração florestal (MACHADO et al., 2014; FIEDLER, OLIVEIRA, 2018). 

O desenvolvimento tecnológico permitiu a introdução de máquinas com design 

ergonômico; máquina com cabeçote de corte e acumulador (Feller-buncher), que 

permitem fazer feixes para o arraste; e máquinas com cabeçote de corte e 

processador (Harvester), permitindo maior progresso do setor florestal brasileiro 

(MACHADO, 2014).  

De acordo com Lima e Leite (2002), os tratores florestais utilizados na colheita 

mecanizada possuem recursos que os deixam muito à frente dos tratores agrícolas. 

Tais maquinários são pesados e de grande porte, com elevada potência e maior 

capacidade de deslocamento, aumentando sua eficiência operacional. As máquinas 

mais utilizadas para a colheita de madeira pelo sistema Cut to Lenght, são o colhedor 

florestal (Harvester) e o trator florestal autocarregável (Forwarder).  
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2.5.1. Harvester 

Harvester é um colhedor florestal, que realiza as operações de corte florestal, 

possuindo a capacidade de efetuar o processamento da madeira ainda no local de 

abate, sendo um trator derrubador, desgalhador, traçador e empilhador, como 

demonstrado na figura 1. (MALINOVSKI e MALINOVSKI, 1998; BURLA, 2008; 

ROBERT, 2018). 

 

Figura 1: Harvester de pneus. 

Fonte: John Deere. 

 

No caso do one grip Harvester, o cabeçote corta, desgalha e traça, e para o 

two grip Harvester o cabeçote somente tem a função de corte, estando sobre o eixo 

traseiro da máquina base os implementos para desgalhamento e traçamento 

(MALINOVSKI; MALINOVSKI, 1998). 

As principais características do Harvester são um conjunto motriz de alta 

mobilidade e boa estabilidade, cabine devidamente fechada, permitindo a 

movimentação de 180º de giro, contendo proteção contra quedas de galhos e árvores. 

O Harvester pode ter base de esteiras ou pneus. O Harvester de pneu apresenta maior 

velocidade e facilidade de locomoção, entretanto provoca maior compactação do solo. 

Já o Harvester de esteira, apesar de apresentar menor velocidade de locomoção, 

possui maior estabilidade em terrenos inclinados (ROBERT, 2018).  

A capacidade produtiva do Harvester pode ser influenciada por fatores de 

ordem técnica e ambiental. Os motivos que mais interferem na colheita são as 

condições climáticas, como o vento e a chuva, características topográficas, e, 
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atributos da própria árvore, como o diâmetro, tamanho dos galhos e da copa, peso e 

qualidade da madeira (SEIXAS, 2007).  

 

2.5.2. Forwarder 

O forwarder é um trator florestal autocarregável, sendo seu carregamento e 

descarregamento realizado por meio de uma grua com garra hidráulica. Essa máquina 

pode ter rodados de esteira, semi-esteiras e pneu com tração 4x4, 6x6, 8x8 e 10x10 

(ROBERT, 2018). 

De acordo com Robert (2018), o forwarder possui um compartimento de carga 

que permite o empilhamento de toras com capacidade de carga entre 10 à 25 

toneladas, dependendo do porte e potência dos motores, com uma produtividade 

média de 30 m³.he-¹ (Figura 2). 

 

Figura 2: Forwarder. 

Fonte: John Deere. 

 

Este trator florestal foi projetado para trabalhar no sistema de toras curtas. 

Apesar de não serem velozes, os forwarder’s possibilitam superar condições adversas 

nos povoamentos florestais e com bom desempenho em áreas com declividades 

medianas. A velocidade não é um fator essencial desta máquina florestal. Em 

decorrência da sua utilização no carregamento e descarregamento da madeira, ela se 

destaca em superar condições adversas no campo (SEIXAS, 2007). 

Esta máquina permite ser equipada com guincho de tração auxiliar (GTA), 

permitindo atividade em regiões com declividade superior a 27º. Com o ancoramento 

do forwarder, sua produtividade diminui, devido ao tempo para realizar a ancoragem 
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do trator e também pelo fato de que a máquina fica impossibilitada de realizar manobra 

para “serpentar” o talhão sem que ocorra perda de tempo operacional por ter que 

retornar ao ponto de ancoragem (ROBERT, 2018).  

 

2.5.3. Guinchos de tração auxiliar  

O guincho de tração auxiliar (GTA) ajuda na redistribuição da potência do 

equipamento, transferindo tração das rodas para outro ponto de ancoragem. Esta 

tecnologia possibilita a utilização do Harvester e Forwarder em áreas com 

declividades acentuadas (FÉLIX, 2015; ROBERT et al., 2013).  

A utilização do GTA, permitiu a locomoção de máquinas como Harvester e 

forwarder em locais nunca transpostos por máquinas sobre rodas ou esteiras. Os 

maquinários ao serem equipados com os guinchos, são ancorados em árvores ou 

âncoras artificiais previamente escolhidas, como mostra a Figura 3, que permitem uma 

operação com maior segurança (FÉLIX, 2015).  

 

Figura 3: Métodos de ancoragem dos GTA’s. 

Fonte: O autor.  

 

A introdução do GTA no Brasil, é algo recente, sendo utilizado nas mesmas 

máquinas que realizam as atividades de colheita de madeira em áreas planas, porém 

adaptadas com guinchos de tração para uso em regiões com declividades superiores 

a 27° (LOPES et al., 2016). 
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2.6. Geotecnologias 

As geotecnologias, são para Rosa (2005), um conjunto de tecnologias para 

coleta, processamento, análise e oferta de informações com referência geográfica. As 

geotecnologias podem facilitar o processo de análise e manipulação de informações 

em grandes áreas.  

O geoprocessamento refere-se a um conjunto de informações relacionadas e 

agrupadas em relação à superfície terrestre, através de um sistema de coordenadas, 

que pode ser Geográfico e/ou UTM (ROSA, 2005). Destaca-se entre as 

geotecnologias mais avançadas e de baixo custo o sistema de posicionamento global, 

o sensoriamento remoto e os sistemas de informações geográficas (FERRARI,2012).  

Atuando de maneira conjunta, o Sensoriamento Remoto e o Sistema de 

Informações Geográficas, permitem obter um panorama do uso e ocupação da terra 

através de um conjunto multitemporal (FLORENZANO, 2002). A utilização de 

ferramentas de geoprocessamento, permite gerar informações uteis com relação ao 

ambiente, por meio de análises geográficas obtidas, processando as imagens e 

realizando a modelagem do terreno (ALBUQUERQUE, 2009). 

Os mapas de uso e ocupação gerados pelas geotecnologias, são resultados 

dos dados da topografia e de aerofotografias obtidas de satélites. Conforme a 

caracterização do solo, pode-se criar diferentes classes para uso e ocupação do solo, 

classificando-as em áreas agrícolas/florestais, massas d’água, edificações, 

afloramento rochosos, entre outros (ALBUQUERQUE,2009) 

O ArcGis®10.3 é um software que coleta, edita, armazena e gerencia dados 

espaciais. É uma ferramenta que permite ser utilizada em diversas áreas, propiciando 

a utilização de técnicas específicas para cada atividade executada (ROSA et al., 

2014). 

O setor florestal tem feito uso de ferramentas de geotecnologia, como o 

Sensoriamento Remoto (SR) e Sistema de Informações Geográficas (SIG), visando o 

planejamento e a otimização da colheita de madeira. Por meio destas ferramentas é 

possível determinar as áreas de plantios, as regiões aptas a implementação da 

colheita de madeira mecanizada, e o momento adequado para iniciar e encerrar as 

operações (LIMA e LEITE, 2014).  
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As operações referentes à colheita de madeira representarem 50% de todos os 

custos gerados nas atividades florestais, a utilização das geotecnologias na colheita, 

tem se mostrado eficiente, permitindo reduzir os custos e aumentar a produtividade. 

Entretanto, apesar da eficiência, as ferramentas de geotecnologia ainda são pouco 

utilizadas para solucionar problemas referente a colheita (MACHADO e LOPES, 

2008).  

.  
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3. MATERIAL E MÉTODOS 

3.1. Área de estudo 

A área de estudo é composta pelo estado do Espírito Santo (ES), situado na região 

Sudeste do Brasil, entre os meridianos de 39º39'36' a 41º52'12'' longitude Oeste de 

Greenwich e os paralelos de 17º53'24'' a 21º18'00'' de latitude Sul. Conforme o IBGE 

(2019), o estado tem uma população de 3.514.952 habitantes, contendo 78 

municípios, e faz divisa com estados da Bahia, Minas Gerais e Rio de Janeiro (Figura 

1). 

Figura 4: Localização geográfica do estado do Espírito Santo, Brasil. 

Fonte: O autor.  

 

O Estado está situado na região tropical e possui um clima quente e chuvoso 

sem a presença de uma estação fria definida (ANTONGIOVANNI e COELHO, 2005). 

Conforme a classificação de Köppen, o Espírito Santo se encaixa nas zonas climáticas 

A e C, sendo a primeiro quente e úmida e a segunda tropical de altitude. O estado 

ainda pode ser classificado de acordo com seu clima, em Am, Aw, CFa, CFb, CWa e 

CWb (SIQUEIRA et al., 2004; SEAG, 2008). 
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A classificação das microrregiões de planejamento utilizadas neste trabalho foi 

baseada na Lei Estadual nº 9.768 de 2011, que subdivide as regiões em macro 

(Metropolitana, Norte, Central e Sul) e microrregiões (Metropolitana, Central Serrana, 

Sudoeste Serrada, Litoral Sul, Central Sul, Caparaó, Rio Doce, Centro-Oeste, 

Nordeste e Noroeste). 

 

3.2. Software utilizado 

Todas as etapas utilizadas no processo de manipulação de dados, como o 

cruzamento e criação de mapas e geração de saídas gráficas envolveram o software 

ArcGis® versão 10.3, utilizando as ferramentas Analysis Tools, Data Manage tools, 

Convertion Tools e Spatial Analyst no ArcMap. 

 

3.3. Base de dados 

Para o zoneamento das regiões aptas para implementação da colheita de 

madeira mecanizada, foram utilizadas informações referentes à declividade e ao uso 

e ocupação da terra. Os mapas de limites de estado e microrregiões foram fornecidos 

pelo Instituto Brasileiro de Geografia e Estatística (IBGE). 

Arquivos de extensão shapefile contendo os polígonos de uso e ocupação da 

terra para o estado do Espírito Santo dos anos de 2012 a 2015 foram obtidos junto ao 

Instituto Estadual de Meio Ambiente e Recursos Hídricos (IEMA). Para o 

mapeamento, o IEMA utilizou ortofotos com escala de 1:25.000 e resolução espacial 

de 25 cm. 

As imagens matriciais provenientes do radar SRTM (Shuttle Radar Topography 

Mission), com resolução espacial de 90m corrigida cartograficamente no sistema de 

coordenadas UTM, datum WGS 1984, foram obtidas no Google Earth Engine. 

A partir de dados de coordenadas geográficas contidos nos planos de manejo, 

fornecidos pelo Instituto Chico Mendes de Conservação da Biodiversidade (ICMBio), 

foram confeccionadas as zonas de amortecimento para as Unidades de Conservação 

(UCs) Federais. Para as UCs que não haviam dados referentes a seu plano de 

manejo, foi dado um Buffer de 3km, como recomendado pela Resolução CONAMA nº 

428 de 17 de dezembro de 2010. Enquanto os arquivos para as áreas e zonas de 
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amortecimento das Unidades de Conservação estaduais foram disponibilizados pelo 

Instituto Estadual de Meio Ambiente e Recursos Hídricos (IEMA).  

A Figura 5, representa uma visão geral das etapas metodológicas realizadas 

desde a obtenção dos dados até o zoneamento para implementação da colheita 

mecanizada. 

 

Figura 5: Fluxograma metodológico. 

Fonte: O autor.  
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3.4. Declividade 

Foi aplicada a ferramenta SLOPE (Spatial Analyst Tools > Surface > Slope) 

para a elaboração do mapa clinográfico do estado do Espírito Santo, em graus. Após 

realizado esse procedimento aplicou-se a ferramenta RECLASSIFY (Spatial Analyst 

Tools > Reclass > Reclassify), com o objetivo de reclassificar as categorias de 

declividade, com base nas potencialidades dos sistemas de colheita mecanizadas. As 

novas classes estão apresentadas na Tabela 1.  

 

Tabela 1: Classes de aptidão de declividade seguidas da descrição do relevo.  

Classes de declividade (º) Descrição do terreno Aptidão 

0 - 27 Plano a ondulado Apta 

27,1 - 35 Acidentado Apta com restrição tipo I 

> 35 Declivoso Inapta 

Fonte: Robert et al., (2013) e Lopes et al., (2016), adaptado pelo autor. 

 

A classe de aptidão de declividade de 0 a 27º se mostra apta a implementação 

da colheita de madeira mecanizada sem a utilização de cabos de tração, mantendo -

se uma boa produtividade, conforme citado por Robert et al., (2013).  

Para regiões com declividade entre 27,1 – 35°, a colheita mecanizada torna-se 

possível com a utilização de guinchos de tração auxiliar - GTA, conforme Lopes et al., 

(2016). Entretanto, para áreas com declividade superior a 35°, a mecanização não é 

possível, pois inviabiliza a utilização dos maquinários destinados a essas atividades.  

 

3.5. Uso e ocupação da terra 

As informações de uso e ocupação da terra, permitiram compreender a 

organização do espaço geográfico do estado do Espírito Santo, possibilitando a 

discretização das seguintes classes: Afloramento rochoso, área edificada, brejos, 

cultivo agrícola anual e perene, massa d’água, mangue, restinga, extração mineral, 

solo exposto, reflorestamento, pastagem, macega, campo rupestre e outros.  

Para determinar a influência de cada classe na implementação da colheita 

mecanizada na área de estudo, foram calculados os valores da tabela de atributos 
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determinando a área de cada classe. Em sequência, o arquivo vetorial poligonal foi 

convertido em formato matricial.  

O uso e ocupação do solo no estado do Espírito Santo, foi classificado de 

acordo com a aptidão aos cultivos florestais, conforme demonstrado no Quadro 1. 

 

Tabela 2: Aptidão às culturas florestais, conforme o uso e cobertura Da terra do Estado 

do Espírito Santo.  

Uso e cobertura do solo Aptidão 

Solo exposto; reflorestamento (pinus, eucalipto e 
seringueira); pastagem; macega. 

Apto 

Agricultura anual. Apto com restrição tipo II 

Outros. Apto com restrição tipo III 

Mata nativa; afloramento rochoso; edificações; 
brejos; agricultura perene; extração mineral; massas 

d'água; mangue e restinga; campo rupestre. 
Inapto 

Fonte: O autor.  

 

As áreas consideradas aptas (solo exposto, reflorestamento de eucalipto e 

pinus, pastagem e macega) permitem o cultivo florestal, pois tratam-se de locais 

disponíveis para plantio e condução.  

Algumas regiões são aptas ao plantio florestal, entretanto apresentam 

limitações como a agricultura anual (apta com restrição tipo II) e locais que não 

puderam ser identificados na fotointerpretação (apta com restrição tipo III). Na primeira 

situação, é possível cultivar espécies florestais, caso as culturas agronômicas 

utilizadas sejam substituídas pelo reflorestamento ao fim de seu ciclo. Porém, na 

restrição tipo III, faz-se necessário verificar as reais condições do local, sendo preciso 

trabalho em campo para analisar a possibilidade de implementar um plantio florestal, 

uma vez que não foi possível verificar a verdadeira condição da área por meio da 

fotointerpretação. 

Locais com presença de mata nativa, afloramento rochoso; edificações; brejos; 

agricultura perene; extração mineral; massas d'água; mangue; campo rupestre e 

restinga, foram classificados como inaptos para o cultivo florestal, pois são regiões da 
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superfície ocupadas para atividades comerciais, áreas destinadas a conservação e 

preservação ou com solos rasos e pedregosos.  

Áreas com a presença de Unidades de Conservação Federal e Estadual, 

juntamente com suas zonas de amortecimento, foram consideradas inaptas, por 

serem áreas destinadas a proteção ambiental.  

 

3.6. Elaboração do zoneamento 

Utilizando o software ArcGis 10.3 foi realizado a combinação dos mapas de 

declividade com o mapa de uso e ocupação da terra do Estado do Espírito Santo. 

Através da ferramenta Combine inserida no ArcToolbox > Spatial Analyst Tools > 

Local > Combine, gerou-se um arquivo contendo informações referentes a cada classe 

de restrição.  

 

3.7. Vetorização da imagem matricial  

O processo de conversão dos dados matriciais em dados vetoriais, para o 

cálculo das áreas aptas e inaptas para implementação da colheita de madeira no 

estado do Espírito Santo, foi executado através do softwarw Arcgis 10.3 utilizando a 

ferramenta Raster to Polygon (ArcToolbox > Conversion Tools > From Raster > Raster 

to Polygon). Após a vetorização da imagem matricial foi obtido 325.125 polígonos. 

Entretanto, após serem dissolvidos (Data Management Tools > Dissolve), obtiveram-

se 5 classes sem repetições.  

Para elaboração das áreas impróprias para implementação da colheita de 

madeira no ES, seguiu-se a metodologia de Santos (2015) considerando as Unidades 

de Conservação (UCs) e suas respectivas zonas de amortecimento. Para as UCs que 

apresentam plano de manejo, foram tabuladas as suas coordenadas geográficas no 

Excel e posteriormente foi importando para o ArcGis, sendo convertidas em ponto 

(Feature to Point) e em sequência em polígonos. Entretanto, para UCs que não 

apresentavam plano de manejo, foi aplicado um Buffer de 3km. Em seguida, aplicou-

se a ferramenta update (Analysis Tools > Overlay > Update). Utilizando as ferramentas 

Calculate Geometry e Field Calculator, foram calculadas a área em hectares (ha) e a 

porcentagem (%) das classes de zoneamento.  
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O tamanho da área também pode ser considerado como uma restrição à 

implementação da mecanização na colheita de madeira. Em nosso estudo, regiões 

com tamanho inferior a 10 ha serão classificadas como inaptas, pois fazer uso de 

grandes máquinas em áreas com dimensões menores a esta, são inviável 

economicamente.  

Portanto, a partir das informações geradas anteriormente, realizou-se um 

Export Data nas classes aptas (apta, apta com restrição tipo I, apta com restrição tipo 

II e apta com restrição tipo III). Posteriormente, os dados foram reclassificados através 

da ferramenta Reclassify, para que as áreas <10 ha se tornassem inaptas à 

mecanização. Em sequência, utilizou-se a ferramenta Update para agregar as novas 

classes de aptidão à tabela de atributos antiga. 
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4. RESULTADOS E DISCUSSÃO  

4.1. Classes de declividade 

As classes de aptidão referentes a declividade para o estado do Espírito Santo, 

são demonstradas na Figura 6.  

 

Figura 6: Caracterização das classes de declividade para o estado do Espírito Santo.  

 

De acordo com os resultados, a classe de aptidão com declividade de 0 – 27º 

(92,82% da área do estado) está presente em todas as microrregiões, com maior 

destaque nas localidades próximas ao litoral (Nordeste, Rio Doce, Metropolitana e 

Litoral Sul). Enquanto 5,21% da área do estado, representa a classe de aptidão com 
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declividade entre 27,1 – 35º, podendo destacar as microrregiões Centro-Oeste, 

Sudoeste Serrana, Central Sul e Caparaó. Observa-se ainda que 1,97% da área não 

permite a utilização da mecanização no processo de colheita, pois trata-se de regiões 

com declividade superior a 35º (Tabela 3).  

 

Tabela 3: Classes de declividade para o estado do Espírito Santo e suas respectivas 
áreas.  

Declividade (°) Área (ha) Porcentagem (%) 

0 - 27 4.276.276,33 92,82 

27,1 - 35 239.998,29 5,21 

> 35  90.584,14 1,97 

TOTAL 4.606.858,76 100,00 

Fonte: O autor. 

 

A implementação da mecanização na colheita de madeira, permitirá melhorar 

as condições de trabalho, propiciando maior segurança aos trabalhadores, elevará a 

produtividade do setor florestal, oferecendo novas alternativas para o plantio e colheita 

de árvores.  

Nas regiões com declividade entre 27,1 e 35°, as atividades mecanizadas só 

poderão ser realizadas utilizando o guincho de tração auxiliar (GTA). Esta tecnologia 

permite que a tração seja melhor distribuída entre os pontos de ancoramento, evitando 

que as rodas patinem, possibilitando o deslocamento com segurança da máquina 

morro a baixo. O GTA, viabilizará o tráfego de tratores florestais em áreas que antes 

intransitáveis.  

 

4.2. Classes de uso e ocupação da terra 

A distribuição espacial das 16 classes de uso e ocupação da terra para o 

Espírito Santo é apresentada na figura 7, onde é possível destacar a utilização do solo 

para o cultivo de pastagens.  
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Figura 7. Mapa de uso e ocupação do solo para o estado do Espírito Santo. Em que, 

AR: Afloramento Rochoso; AE: Área Edificada; BR: Brejo; CR: Campo Rupestre; AA: 
Agricultura Anual; AP: Agricultura Perene; EM: Extração Mineral; MA: Macega; MG: 

Mangue; MD: Massa D’água; MN: Mata Nativa; OT: Outros; PA: Pastagem; RE: 
Reflorestamento; RG: Restinga e SE: Solo Exposto.  

 

As áreas destinas as matas nativas, representam 22,09% do território do 

estado, como demonstra a Tabela 4. O Espírito Santo está inserido no bioma Mata 

Atlântica, e conforme Mendes et al. (2014), este é um dos cinco biomas com maior 

prioridade de preservação mundial, portanto, as regiões ocupadas pelas matas 

nativas tornam-se inaptas à implantação de florestas plantadas. 
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Tabela 4: Áreas ocupadas pelas classes de uso e ocupação do solo no estado do 

Espírito Santo.  

Uso e ocupação da terra Área (ha) Porcentagem (%) 

Afloramento rochoso 132.727,56 2,88 

Área edificada 42.846,64 0,93 

Brejo 125.262,04 2,72 

Campo rupestre 7.499,39 0,16 

Cultivo agrícola (anuais) 150.213,38 3,26 

Cultivo agrícola (perenes) 509.408,46 11,06 

Extração mineral 4.489,00 0,10 

Macega 217.890,61 4,73 

Mangue 8.134,52 0,18 

Massa d'água 61.577,89 1,34 

Mata nativa 1.017.602,31 22,09 

Outros 136.392,59 2,96 

Pastagem 1.801.503,18 39,10 

Reflorestamento 325.678,25 7,07 

Restinga 13.095,37 0,28 

Solo exposto 52.537,57 1,14 

TOTAL 4.606.858,76 100,00 

Fonte: O autor. 

 

Já as florestas plantadas, representadas principalmente pelas espécies de 

eucalipto, pinus e seringueira, ocupam 7,07%, das terras capixabas. Os plantios de 

pinus ocupavam 2.500 ha das terras do estado, enquanto as espécies de eucalipto 

233.760 ha no ano de 2016 (IBA, 2017). Entretanto, a área cultivada por eucalipto 

poderia ser maior, pois de 2001 a 2007, a Lei Estadual n° 6.780, de 03 de outubro de 

2001 impedia o plantio de eucalipto para produção de celulose em todo o estado, 

limitando a expansão dessa cultura.  

A agricultura é uma atividade econômica significativa no Espírito Santo, sendo 

que o cultivo de espécies agrícolas perenes, ocupam 11,06% do estado. De acordo 

com o Incaper (2019), a principal atividade agrícola do estado é a cafeicultura, estando  
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presente em todos os municípios capixabas, exceto Vitória. Na agricultura perene, 

além do café, pode-se destacar a produção de coco e mamão. 

Áreas com predomínio do cultivo agrícola de ciclo longo, são caracterizadas 

como inaptas. A substituição destas culturas, como por exemplo o café, por espécies 

florestais, é dificultado por laços históricos que são passados entre as gerações das 

famílias capixabas, sendo que a cafeicultura fez parte da evolução histórica do Espírito 

Santo. 

O Espírito Santo apresenta 2,88% de seu território coberto por afloramentos 

rochosos. Entre os mais famosos estão a Serra do Caparaó, onde está localizado o 

Pico da Bandeira com 2.892m de altura, o Pico do Forno Grande (2.070m) e a Pedra 

Azul (1.822m), localizados respectivamente nas microrregiões do Caparaó e Sudoeste 

Serrana. Mais ao norte do estado, na microrregião Noroeste destaca-se os Pontões 

Capixabas (SETUR, 2019). Nas áreas com predominância dos afloramentos 

rochosos, a implementação da mecanização nas atividades florestais é inapta, pois 

trata-se de locais com elevada altitude e declividade, e em muitos casos, essas terras 

são utilizadas como unidades de conservação.  

As Unidades de Conservação, juntamente com suas zonas de amortecimento 

representam 10.53% da área útil do estado, entretanto, apresentam outras classes de 

uso e ocupação da terra em seu interior. Estas regiões são destinadas a conservação 

e com regime de administração especial como determina a Lei Nº 9.985, de 18 de 

julho de 2000. Portanto, estas áreas foram classificadas como impróprias para 

implementação da mecanização.  

As áreas com solo exposto (1,14%), podem se tornar um problema, pois a terra 

fica desprotegida, mais susceptível a erosão e a degradação do solo e em muitos 

casos pode a ocorrer a desertificação do local. Implementar árvores nessas regiões 

evitará que este problema ocorra, e consequentemente ajudará a aumentar a 

produtividade do setor florestal.  

 

4.3. Aptidão a implementação da colheita mecanizada 

Na Tabela 5, é apresentado as classes de aptidão à implementação da colheita 

de madeira no Espírito Santo. O estado apresenta 44,00% do seu território apto à 

implementação mecanização, sem a necessidade de utilizar guinchos de tração 
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auxiliar, pois trata-se de regiões com declividade inferior a 27º e com uso e ocupação 

do solo que permitem o cultivo de florestas e suas atividades afins.  

 

Tabela 5: Classes de aptidão à implementação da colheita mecanizada no estado do 

Espírito Santo.  

Aptidão Área (ha) Porcentagem (%) 

Apto 2.027.161,35 44,00 

Apto com restrição tipo I 3.296,05 0,07 

Apto com restrição tipo II 92.338,40 2,00 

Apto com restrição tipo III 25.952,86 0,56 

Áreas impróprias  485.100,45 10,53 

Inapto  1.973.009,65 42,83 

Total 4.606.858,76 100,00 

Fonte: O autor. 

 

Em contrapartida, 42,83% das terras capixabas são inaptas para utilização da 

colheita mecanizada, pois trata-se de áreas com declividade superior a 35º e que não 

permitem a utilização dos maquinários necessários para esta atividade ou por se tratar 

de áreas já ocupadas e destinada a outra finalidade. Além disso, 10,53% do estado 

são impróprias para as atividades florestais, pois são áreas de Unidades de 

Conservação e suas respectivas Zonas de Amortecimento.  

De modo geral, as microrregiões Noroeste e Nordeste destacam-se entre as 

regiões aptas à mecanização, com 62,80% e 52,77% de suas respectivas áreas, como 

pode ser observado na tabela 6.
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Tabela 6: Classes de aptidão à mecanização da colheita de madeira, distribuídas de acordo com cada microrregião. 

Microrregiões 

Aptidão 
Caparaó Central Serrana Central Sul Centro Oeste Litoral Sul 

Área (ha)  Porcentagem (%) Área (ha)  Porcentagem (%) Área (ha)  Porcentagem (%) Área (ha)  Porcentagem (%) Área (ha)  Porcentagem (%) 

Apto 145020,82 37,84 75544,02 25,46 149740,54 40,11 244356,69 43,60 140865,49 50,51 

Apto com restrição tipo I 811,95 0,21 98,42 0,03 402,06 0,11 764,26 0,14 389,62 0,14 

Apto com restrição tipo II 129,60 0,03 3601,72 1,21 469,92 0,13 835,12 0,15 12757,13 4,57 

Apto com restrição tipo III 1025,46 0,27 502,23 0,17 1857,38 0,50 2449,27 0,44 1817,81 0,65 

Áreas impróprias  94269,99 24,60 9479,42 3,19 75160,82 20,13 42077,60 7,51 13952,97 5,00 

Inapto  142022,71 37,05 207486,04 69,93 145681,14 39,02 269937,78 48,17 109097,82 39,12 

Aptidão Metropolitana Nordeste Noroeste Rio Doce Sudoeste Serrana 

  Área (ha)  Porcentagem (%) Área (ha)  Porcentagem (%) Área (ha)  Porcentagem (%) Área (ha)  Porcentagem (%) Área (ha)  Porcentagem (%) 

Apto 69937,78 30,20 422912,75 52,77 398750,27 62,80 268431,78 40,43 111594,72 29,19 

Apto com restrição tipo I 52,75 0,02 0,00 0,00 169,19 0,03 84,58 0,01 516,73 0,14 

Apto com restrição tipo II 213,28 0,09 55743,44 6,96 633,38 0,10 16040,67 2,42 1907,65 0,50 

Apto com restrição tipo III 9506,32 4,11 2357,98 0,29 1401,58 0,22 3833,81 0,58 1194,53 0,31 

Áreas impróprias  33854,13 14,62 98111,94 12,24 11968,37 1,88 79446,33 11,97 26772,40 7,00 

Inapto  117989,38 50,96 222309,36 27,74 222035,86 34,97 296087,52 44,60 240355,56 62,86 

Fonte: O autor. 
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As microrregiões Noroeste e Nordeste, situam se próximas as grandes 

indústrias de papel e celulose, presentes na cidade de Aracruz-ES e no Extremo Sul 

da Bahia. Além disso, algumas cidades dessas regiões como Conceição da Barra e 

São Mateus, estão entre as 20 maiores cidades produtoras de madeira em torete para 

papel e celulose (IBGE, 2015; IBGE, 2016). A alta proporção de áreas com declividade 

entre 0 e 27°, garantem maior nível de mecanização nas microrregiões Nordeste e 

Noroeste e consequentemente maiores produtividades são alcançadas.  

O Litoral Sul capixaba, apresenta 50,51% de suas terras propícias a 

mecanização florestal. De acordo com o Instituto de Apoio à Pesquisa e ao 

Desenvolvimento Jones dos Santos Neves (2000), cerca de 58,3% das terras 

produtivas dessa microrregião é coberta por pastagem. 

A região Metropolitana apresentara 50,96% de suas áreas como inaptas a 

implementação da colheita mecanizada. Dados do IBGE (2019), afirmam que cerca 

de 49% de toda a população capixaba vive nos 7 municípios dessa microrregião e 

consequentemente essa apresenta grande parte de seu território ocupado por 

edificações.  

O Espírito Santo é um estado litorâneo, que contempla a presença de mangue 

e restinga ao longo do litoral, o que justifica a necessidade de preservar esses 

ambientes. Tais características reduzem a implementação de povoamentos florestais, 

caracterizando estas regiões com influência do mar como inaptas.  

Outras microrregiões que apresentam elevados percentuais de áreas inaptas à 

mecanização, são a Central Serrana (69,93%) e Sudoeste Serrana (62,86%). A 

presença de um relevo mais acidentado e com presença de afloramentos rochosos, 

faz com que essas microrregiões apresentem áreas com declividade superior a 35º, 

impossibilitando a utilização de máquinas de grande porte.  

Todas as regiões do estado, com exceção do Nordeste permitem a utilização 

do guincho de tração auxiliar – GTA (apta com restrição tipo I), correspondendo a 

3.296,05 ha, representando menos de 1% de toda a área do Espírito Santo (Tabela 

5). Entretanto, as microrregiões Caparaó (811,95 ha), Centro Oeste (764,26 ha), 

Sudoeste Serrana (516,73 ha) e Litoral Sul (389,62 ha), são as que apresentam as 

maiores áreas que possibilitam a utilização do GTA. 

A utilização do GTA, permitirá a introdução da mecanização em terrenos 

declivosos (27,1 – 35°), substituindo o uso dos sistemas manual e semimecanizado, 
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situação impossível de ocorrer com os maquinários tradicionais. Ao adotar o sistema 

mecanizado, o custo de produção e o número de acidentes durante a operação reduz, 

tornando-se um atrativo, conforme o estudo de Farias (2016). 

As áreas com cultivo agrícola anual e que se encontram em local com 

declividade de até 27° (apta com restrição tipo II), permitem implementar a 

mecanização e ocupam 92.338,40 ha, representando 2,00%  

(Tabela 5) da superfície do Espírito Santo. O Nordeste, Litoral Sul e Rio Doce, 

apresentam respectivamente 55.743,44, 12.757,13 e 16.040,67 ha que se 

caracterizam nessa classe de aptidão.  

Como nas regiões caracterizadas como aptas com restrição tipo II são 

ocupadas pelo cultivo agrícola anual, deve-se elaborar um estudo econômico/ 

logístico afim de avaliar se a substituição do cultivo agrícola de ciclo curto por espécies 

florestais será vantajosa ou não.  

O cultivo de cana-de-açúcar no Espirito Santo ocupa aproximadamente 60 mil 

hectares, sendo a espécie de ciclo curto mais produzida (DADALTO, 2016). A cidade 

com maior produtividade de cana-de-açúcar é Linhares, seguida respectivamente por 

Conceição da Barra, Pedro Canário, Pinheiros, Itapemirim e Montanha (IBGE, 2018). 

As microrregiões Nordeste, Litoral Sul e Rio Doce contemplam as cidades com 

maior produtividade da cana-de-açúcar, e apresentam respectivamente 6,96%, 4,57% 

e 2,42% de sua área apta à mecanização, entretanto, com o uso e ocupação da terra 

destinado a agricultura de ciclo curto.  

Com relação a ocupação do solo, das espécies anuais, depois da cana-de-

açúcar está o milho com cerca de 18 mil hectares distribuídos pelo estado do Espírito 

Santo (IJSN, 2016). Desta forma, o cultivo de milho pode ser um fator limitante, à 

produção florestal, uma vez que ocupa regiões aptas por declividade do presente 

estudo. 

Pode se destacar também a produção de abacaxi no estado, sendo que, nos 

últimos anos, o Litoral Sul foi responsável por 98,06% da safra estadual (CEDAGRO, 

2011). O desenvolvimento dessas culturas, impede o crescimento de 

empreendimentos florestais na região, apesar da declividade possibilitar a introdução 

de florestas plantadas utilizando o sistema mecanizado.  
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A Figura 8, demonstra a distribuição das classes de aptidão em todo o Espírito 

Santo, representado as áreas sujeitas ou não a implementação da mecanização.   

 

Figura 8: Mapa com as classes de aptidão para o Estado do Espírito Santo. 

 

Algumas regiões foram caracterizadas como inaptas, pois apresentaram 

tamanho inferior a 10 ha, porém estão localizadas em territórios com declividade entre 

27,1 – 35° e com a presença de cultivo agrícola anual (apta com restrição tipo I e II), 

portanto podem ser utilizadas para o cultivo florestal. Entretanto, nessas áreas é 

preciso verificar a viabilidade econômica e logística para substituir as espécies 

agrícolas por florestais e introduzir maquinários utilizando o guincho de tração auxiliar 
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(GTA). Deve-se considerar nessas analises a proximidade de locais que fazem o uso 

do GTA.  

A classe apta com restrição tipo III, representa 25.952,86 ha do estado, estando 

presente em todas as microrregiões. Neste caso, o fator limitante à mecanização é o 

uso e ocupação da terra, não sendo possível determinar as atividades desenvolvidas 

nesses lugares. Portanto, para implementação de atividades florestais nas regiões 

com esta restrição, torna-se necessário verificar como estas áreas são utilizadas.  

As áreas definidas como impróprias neste estudo, são destinadas a Unidades 

de Conservação e suas respectivas Zonas de Amortecimento, e, de acordo com a 

tabela 5 representam 10,53% de toda área do território capixaba. 

A Figura 9, demonstra todas as classes de aptidão distribuídas em cada 

microrregião do Espírito Santo. Analisando o mapa, as áreas caracterizadas como 

impróprias estão distribuídas por todo o estado.  
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Figura 9: Mapa com as classes de aptidão conforme as microrregiões do estado do Espírito Santo. Em que, A: Caparaó; B: Central 

Serrana; C: Central Sul; D: Centro-Oeste; E: Litoral Sul; F: Metropolitana; G: Nordeste; H:Noroeste; I: Rio Doce: J: Sudoeste Serrana. 
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O Parque Nacional do Caparaó, localizado na divisa entre os estados de Minas 

Gerais e Espírito Santo, abrange um território de aproximadamente 31,8 mil hectares, 

sendo cerca de 80% do parque situado em terras capixabas, microrregião do Caparaó 

(ICMBio, 2019). Apesar de apresentar bons resultados com relação a áreas aptas e 

aptas com restrição tipo I, a presença do PARNA Caparaó de acordo com a Tabela 5, 

contribui em boa parte dos 24,60% das áreas impróprias de toda essa região. 

A microrregião Central Sul apresenta 39,02% de sua área classificada como 

imprópria, devido a presença das seguintes áreas de conservação: o Parque Estadual 

do Forno Grande, o Monumento Natural o Frade e a Freira, o Parque Estadual Mata 

das Flores, o Monumento Natural Serra das Torres e o Parque Estadual Cachoeira da 

Fumaça.  

A presença das Unidades de Conservação, evidencia que uma grande área do 

Espírito Santo deve ser preservada e que as atividades ao seu redor, dentro de suas 

zonas de amortecimento seguem normas especificas, não possibilitando o cultivo de 

floresta plantada nessas regiões. 

Em termos práticas, todos esses resultados evidenciam que é possível elevar 

o nível de mecanização do estado do Espírito Santo, mesmo respeito as áreas 

destinadas a preservação ambiental.  
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5. CONCLUSÕES 

Pode-se implantar o cultivo florestal e consequentemente implementar a 

colheita mecanizada em todas as microrregiões do Espírito Santo.  

As microrregiões Central Serrana e Sudoeste Serrana apresentam mais da 

metade da sua área inapta a mecanização, devido principalmente as suas condições 

de relevo (declividade superior à 35º).  

A classe predominante de uso e ocupação da terra se refere a pastagem. Essas 

terras apresentam a possibilidade de implementação de espécies florestais, porém, a 

utilização de atividades mecanizadas, dependerá também                                                                                  

da declividade do local.  

A utilização de guincho de tração auxiliar só não será possível na microrregião 

Nordeste. 

As microrregiões Nordeste e Noroeste apresentaram os melhores resultados 

em relação a implementação da mecanização, pois tratam-se de regiões com relevo 

mais plano e com o uso da terra destinado em sua maioria a pastagens. 

Pode-se aumentar o tamanho das áreas destinadas ao cultivo florestal e 

consequentemente elevar o nível de mecanização no estado, substituindo o cultivo 

agrícola de ciclo curto e pastagens por espécies florestais. Entretanto, é necessário 

realizar estudo de viabilidade econômica. 
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